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At Plymouth Christian, our students enjoy a learning environment rich in technology 
across the curriculum. Every PCA classroom from Begindergarten through 12th grade 
features SMART Board technology. There are three computer labs available to students 
of all ages: Elementary Computer Lab, Middle School Computer Lab, and High School 
Computer Lab. During the summer of 2014, the Elementary Computer Lab was upgraded 
with 25 Lenovo Think Stations. 
 
PCA Elementary (grades K-6) has approximately 22 classrooms each with network 
access, a teacher computer, projector and a smartboard.  Teachers have access to one 
general-purpose lab that has at least 24 computers.   
 
Through the Elementary Computer Technology Curriculum, for third through sixth grade, 
students will develop basic skills in computer fundamentals, keyboarding, computer 
applications, research tools, and educational applications. Students will be provided with 
opportunities to apply computer applications such as Microsoft Office, i.e., word 
processing, excel spreadsheets, multi-media programs, publisher, PowerPoint 
presentation across the curriculum, internet and cyber safety lessons. 
 
K-6 uses the Typing Master Online software to teach touch typing mastery. Typing 
Master Online is a web-based touch-typing course that incorporates daily practice 
schedules, assessments to track and assess student progress and adjust the course for each 
class.   
 
Elementary Computer Curriculum Goals 
 
Our goals are to enable all students to: 
 

1. Demonstrate a basic knowledge of computer technology-its 
         function and application. 
2. Demonstrate keyboard proficiency within developmental    
         guidelines.  
3. Use the computer as a medium for integrating all areas 
         of the curriculum. 
4. Create original products of their learning using technology/ multimedia tools.  
5. Expand their critical thinking skills through the use of computer simulations.  
6. Reinforce their basic skills knowledge through the use of computer software.  
7. Gain appreciation for careers that involve technology. 
8. Gain self-esteem, independent thinking skills, and confidence through 

experiences with new and challenging technology. 
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Computer Curriculum Outline     

 

I. Computer Awareness Objectives 
A. Identify/Instruct the five major parts of a computer: 

1. Central Processing Unit  

• It is the hardware used in the computation of data.  
• It is the "brain" of the computer.  
• Also known as the CPU.  

2. Monitor  

• This provides the visual display of the information.  
• It is not a television set. Monitors have a higher resolution 
which enables users to read small fonts on screen.  

3. User input devices  

• Keyboard - This is in the same basic format as typewriters.  
• Mouse - This is used to make selections and decisions on 

screen.  
• Scanner - This is used to convert a picture into digital 

information which can then be used or edited by the 
computer.  

• Modem - This is used to link computers via the phone 
lines.  

4. Storage/Input devices  

• Removable Disk Drives - Provides the user with 
removable memory sources.  

• Hard Disk Drives - Provides the user with a large, fast, 
and dependable memory source. These are usually part of 
the actual computer and are not removable.  

• Compact Disc Drives - Identical to audio CD's in size and 
benefits. Both provide the user with a very large and 
dependable memory source.  

5. Output devices  

• Printer - Printer which sprays ink through tiny nozzles onto 
the paper. Provides inexpensive quality printing.  
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B. Define and use appropriate computer terms  

• Each grade will use the appropriate terms for its level.  
• The terms will be reinforced through use by the students.  
• Computer specialist will concentrate on using correct terminology.  
• Terms included in the weekly vocabulary games. 

C. Understand that there are a variety of computer types  

• There is more than one manufacturer of computers.  
• Each manufacturer uses its own operating system.  
• Software for one system will not run on another without 

translation.  

D. Describe common uses for the computer  
1. Word Processor - The electronic manipulation of text characters. 

This includes letters, papers, and even longer documents.  
2. Desktop Publishing - Electronic page layouts for newsletters, 

magazines, flyers, etc. This usually includes the combination of 
text and graphics.  

3. Database - The electronic manipulation of information. Being able 
to sort, organize, or find specific items out of large collections of 
information. Also used to keep repetitive records such as addresses 
or employee information.  

4. Spreadsheet - The electronic manipulation of numbers. Used for 
statistical analysis, accounting, or number crunching applications.  

5. Graphics - The electronic manipulation of graphical images. Used 
to edit still pictures, slides, scanned images, or full motion video.  

6. Audio - The electronic manipulation of digital audio sounds. Used 
in the manufacture of compact discs and digital tapes as well as 
overlaying existing video with a digital soundtrack.  

7. Communication - Sending digital messages from one computer to 
another / e-mail 

8. Describe ways computers affect people's lives. 
9. Used to find sources in libraries.  
10. Used to keep records for credit cards and other financial 

establishments.  
11. Used to entertain (video games).  
12. Used to check out in the grocery store (scanners).  
13. Used to calculate math in the home (calculators).  
14. Used to control accuracy in the manufacture of our modern 

products.  
15. Used as safety systems in today's cars, planes, and other vehicles.  
16. The list goes on and on.  

E. Identify computer related occupations  
1. Architect - aids in the design of modern buildings.  
2. Engineer - used to test possible designs (bridges, vehicles, etc.).  
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3. Accounting - used to speed up the record keeping.  
4. Medicine - used for quantitative analysis, etc.  
5. Database Manager - used for the management of company 

customer lists, product lists, service listings, etc.  
6. The list goes on and on.  

F. Understanding copyright laws  
1. All commercial software is copyrighted. This means a limited 

number of copies may be made with permission from the 
manufacturer.  

2. All shareware is copyrighted. This means a limited number of 
copies may be made with permission from the manufacturer.  

3. All freeware is copyrighted. However, an unlimited number of 
copies may be made without permission from the manufacturer.  

4. All public domain software is not copyrighted. This means an 
unlimited number of copies may be made without permission from 
the manufacturer.  

5. As leaders for our children it is imperative that we set an example 
by obeying copyright laws, avoiding plagiarism.  

G. Privacy implications with computers  

 

II. Computer Skills Objectives  

Basic:  Identify numbers and letters on the keyboard  

1. Students should recognize the alphabet on the keyboard.  
2. Students should recognize the difference between upper and lower 

case letters.  
A. Keyboarding  

1. Students will build on keyboard knowledge learned in previous 
grades. 

2. Students will be expected to use correct fingering in typing.  
3. Students will use PCA’s keyboard tutoring programs (Typing 

Master Online) to accomplish this.  
4. Students will use their keyboarding skills to accomplish a variety 

of computer manipulations.  
B. Identify and use keyboard shortcuts  

1. Students will be able to use the command-key combinations to 
accomplish tasks quicker.  

2. Students will be able to assign keyboard shortcuts or function keys 
to macros.  

C. Proper care of software and hardware  
1. Software is magnetic in nature and should thus be kept away from 

any magnetic field generators i.e. tops of disk drives, magnets, x - 
ray machines, metal detectors, etc.  
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2. Software disks should be handled with care. Hardware is also 
picky about what is put inside of it. Liquids, crumbs, erasers, etc. 
don't sit too well.  

3. Dust the machine regularly, clean the inside of the mouse, and 
follow any other cleaning suggestions from the manufacturer.  

D. Ability to manipulate the mouse  
1. Ability to move the mouse to specific items.  
2. Ability to select those items with the mouse button or right mouse 

click   
3. Recognize and apply mouse terms such as click, shift click, click 

and drag, highlight, etc.  
E. Ability to power up and power down a system  

1. Simply turn power switch on and wait for system to power up.  
2. To shut the system down, choose shutdown from the special menu, 

wait until the system has organized itself and told you it is O.K. to 
shut off the power, and turn off the power switch.  

III. Computer Usage Objectives  

A. Operating the Laptop  
1. Using the File Menu / Standard toolbar buttons, etc. 

a. New - Students will use this menu command to create new 
folders or documents within applications.  

b. Open - Students will use this menu command to open 
previously created folders and documents.  

c. Close - Students will use this menu command to close the 
current folder, document, or window.  

d. Save - Students will use this menu command to 
periodically save an already named document while they 
are working on it.  

e. Save As... - Students will use this menu command to name, 
place in a folder, and then save a newly created document 
or to rename an older document.  

f. Page Setup - Students will use this menu command to give 
specific commands to the printer concerning the type of 
paper being used.  

g. Print - Students will use this menu command to give 
special commands to the printer concerning print quality, 
number of copies, page orientation, and to print their 
documents.  

h. Close - Students will use this menu command to quit the 
current application.  

i. Copy - Students will learn to copy files to flash drives. 
j. Other commands may appear in this menu depending upon 

the application.  
2. Using the Edit Menu  
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• Undo - Students will use this menu command to undo the 
last command given to the computer. Not all commands are 
undoable.  

• Cut - Students will use this menu command to cut a 
selection from a document, removing it from the master, 
and placing it on the clipboard.  

• Copy - Students will use this menu command to copy a 
selection from a document, leaving the master intact, and 
placing it on the clipboard.  

• Paste - Students will use this menu command to place the 
contents of the clipboard into a document.  

• Clear - Students will use this menu command to clear a 
selection from the screen. This is similar to deleting text.  

• Select All - Students will use this menu command to select 
all of the objects or text in a document.  

• Publishing - Students will use this menu command to 
publish documents to appear automatically in other 
documents called subscribers.  

• Special Functions - The Edit Menu will contain special 
functions depending on the application. See the specific 
lesson manual for more information.  

3. Using the View Menu - This menu gives the students the ability to 
change the way they are viewing the screen.  

• Some common menu items would be tools, rulers, 
grids, invisibles, etc.  

4. Using the Help Menu - Students will use this menu to receive 
online help for a particular application.  

5. Using the Application Menu  

• Hide - Students will use this menu command to hide a 
particular application from view. The application is still on 
the desktop and running.  

• Show - Students will use this menu command to show an 
application that had been previously hidden.  

• Finder - Students will use this menu command to toggle 
between the application they are running and the finder.  

• Students will also use this menu to toggle between two 
applications being run simultaneously.  

6. Using Pop-Up Windows - Students will use these windows to 
interact with the specific application to open, save, correct spelling, 
etc.  These windows maintain a common format from application 
to application.  

B. Interact with drill and practice applications  
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• Students will be able to select and launch these applications.  
• Students will be able to work with a particular application's menus 

to accomplish their task.  
• Students will be able to quit these applications.  

C. Interact with the Operating System  

• Students will be able to select and launch these applications.  
• Students will be able to work with a particular application's menus 

to accomplish their task.  
• Students will be able to quit these applications.  

D. Word Processing  

• Students will use correct formatting techniques, including tabs and 
paragraph rulers, when creating WP documents.  

• Students will use the art library/internet to add graphics to their 
word processing document.  

• Students will use keyboarding skills to produce written 
assignments.  

• Students will use the word processor to complete projects accross 
the curriculum  for language, social studies, science, etc. classes.  

• Students will use the spell checker to aid in proofreading their 
documents.  

E. Database  

§ Students will learn the structure of a database.  
§ Students will create their own database.  

• Students will create an address book.  
• Students will create an imaginary product listing.  
• Students will create a new database as computer specialist 

designs.  
§ Students will use existing databases.  

F. Spreadsheet  
1. Students will learn that the spreadsheet is composed of rows and 

columns  

a. Columns are vertical division on the page with each 
column being labeled with a letter. Most spreadsheets contain 
256 columns.  
b. Rows are horizontal divisions on the page with each row 
being labeled with a number. Most spreadsheets contain 
14,000+ rows.  

2. Students will use the spreadsheet as a calculator.  
3. Students will use the spreadsheet to graph numeric values.  
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4. Students will use the spreadsheet to organize information into 
tables.  

G. Graphics  
1. Students will be able to use and modify clip art in their documents.  
2. Students will be able to use the assorted drawing tools.  

1. To make scale drawings.  
2. To draw diagrams.  

3. Students will be able to use the painting tools.  
H. Desktop Publishing  

1. Students will publish a classroom newsletter.  
2. Students will produce posters and signs.  
3. Students will create a topical slide show.  

I. Internet 
1. Students will view grade level selected web pages which have been 

teacher approved to increase the curriculum resources.  
2. Students will learn how to formulate searches.  
3. Students will browse online "web sites" for research purposes.  
4. Students will categorize their sites using bookmarks.  
5. Students will use the web to download appropriate files.  

J. E-Mail  
1. Students will learn the fundamental types of e-mail service.  
2. Students will learn about netiquette in using electronic 

communication.  
K. On-going Projects 

1. Resume 
2. Business Card 
3. Envelope 
4. Name Card 
5. Brochure 
6. Flyers 
7. Posters 
8. Tickets 
9. Advertisements 
10. Labels 

 


